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Summary: A “critical path” is the longest duration of a set series of activities to a major event. The 
OPDEC Critical Path tool is an add-on to Microsoft Project that displays a graphic representation of 
up to 10 critical paths and their associated integration points. It provides a quick analysis of the 
critical paths to major events in the Integrated Master Schedule (IMS).   

 

Example: (Critical Paths 1-5 to Selloff Unit 5”), displays the top 5 critical paths to the event. The 
legend, (Path 1, Path 2, etc.), shows the float (slack) for each path. The user is now equipped with 
the required reference points to enable quick analysis of the IMS mapping network.  
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Minimum Software Requirements 
• Milestones Professional 2015 (www.kidasa.com) 

• Microsoft Project 2010 

• Microsoft .NET Framework 4.5 
 

Installation 
1) Download the installation file from www.opdec.com/ms-project-tools/critical-path-tool 
2) Extract the executable from within the ZIP folder.  

a. Double-click the ZIP folder to open it, and then drag-and-drop the executable file within 
to your Desktop. 

3) Double-click the executable file to launch the installation wizard. Note that you will need 
administrator privilege on the device to complete the install. 

4) Follow the prompts to accept the EULA and install the add-in. 
  

http://www.kidasa.com/
http://www.opdec.com/ms-project-tools/critical-path-tool
http://www.kidasa.com/Download/index.html
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Activation 
1) Open Microsoft Project 
2) Navigate to the OPDEC ribbon tab and click the Critical Path 2024 button. 
3) Upon first launch, you will be presented with the activation window. The activation process 

can be delayed for up to 30 days using the Activate Later button. 
 

 
4) If you have an internet connection on your device, click Activate Now. 

a. Fill in your name, email, company, and assigned serial number provided upon 
purchase of the software. It is an 8-digit, alphanumeric code separated by a dash (e.g. 
a1b2-c3d4). 
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b. Click OK and your 
activation will be 
complete. Note that 
security settings can 
prevent the online 
activation. Please see step 
#5 if so. 
 
 
 
 
 
 

5) If you do not have an internet connection, click Obtain via Telephone or Email in Step 2: 
Offline Activation. 

a. A popup will appear displaying your device’s unique identifier. 
 

 
 

b. You will need to provide this to OPDEC Support along with your serial number to 
receive an activation key. You can email us at support@opdec.com using the Send 
Email button or call us at (256) 881-1038. 
 
 
 

 
 
 
  

mailto:support@opdec.com
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Milestones Professional Setup 
There is an option in Milestones Professional that allows the Critical Path tool to automate it more 
effectively. This option does not interfere with any manual use of the Milestones Professional 
software, so we recommend setting this option when you install the tool. 
 

1. Open Milestones Professional 
2. Navigate to the Tools ribbon, and select the Files and Automation button in the  

Program Options subgroup. 
 

 
 

3. Next, check the Run as Multiple Instances for COM Automation as seen below. Setting this 
option will require administrator privileges on your PC. 
 

 
 

4. Click the Run ReReg.exe to recreate Milestones Com and file association registry entries. 
button. This button runs a process that recreates the registry keys needed for the 
application to run correctly. These help the Critical Path tool detect that Milestones 
Professional is installed on the device and helps the Critical Path tool automate Milestones 
Professional. 
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Create a Settings Profile 
You must establish a Settings Profile before creating a Critical Path chart. Click the Settings tab. 
 

 
 
Start with either the Default Profile or click Profile -> Create New Profile. This Settings Profile 
identifies key information within your schedule the tool needs to perform its calculations. You can 
either use the same fields across all your schedules or create multiple profiles corresponding to 
each schedule. 
 
Settings Profile names are saved to the Microsoft Project file as a custom document property. This 
allows each file to associate itself with one of your Settings Profiles. You can see the name of the 
Settings Profile that is currently associated with the schedule in the top-right corner of the Settings 
tab. If a profile name is saved to the file but you do not have a matching, valid Settings Profile, you 
will see a warning appear when the tool launches. To avoid that warning, you can either create a 
new Settings Profile with the requested name or run a critical path using a different Settings 
Profile. The custom document properties are saved along with the schedule file, so closing a file 
without saving will prevent this tag from being retained. 
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Required Settings 
 

First, populate each of the Required Settings seen in the image below. You must provide 
information for each to run a critical path. To get started quickly, use the Default Profile.  

 

• Milestone Template Location 
o This setting provides the directory containing your Milestones Professional templates 

used by the tool.  
o The default templates are saved in a “Templates” folder within the application directory 

you selected during installation. This path can change depending on your device, but is 
most often located here: C:\Program Files (x86)\OPDEC Tools\Critical Path 
2024\Templates 

 

• Result Save Location 
o This setting identifies where the tool will save the files it produces. 
 

• Empty Text Field 
o This setting targets a custom Text field within Microsoft Project that the tool can utilize.  
o The tool will store path identification data in this field, and it will clear the contents of 

this field repeatedly during processing. Make sure you pick a field not in use. 
 

• Major Event Field 
o This setting targets a custom Text or Number field within Project that identifies the Major 

Event tasks (aka Milestones) of the schedule. 
o Every task identified as a Major Event by this field will have its Deadline and Constraint 

Type cleared (set to “NA” or “As Soon As Possible”, respectively) before the tool runs. 
This allows the tool to calculate an accurate critical path based only on duration and 
logic. 

o The identification is made by the user entering a unique value in the field. Major Event 
tasks are often 0-day duration tasks that mark significant progress in a schedule. These 
are the tasks that a user will typically be running critical paths to. If you want to honor a 
constraint or deadline in the critical path chart, leave the Major Event field blank (if Text) 
or equal to 0 (if Number) for the desired task(s). 

 

• Target Date Field 
o This setting specifies the date the targeted task (that the critical path is being run to) 

must be complete by.  
o If you are unsure, the “Baseline Finish” field is a good starting point, assuming your 

schedule is baselined. However, all date fields within Project are available as options 
since many users prefer custom target dates.  
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o Alternatively, the user may manually enter their own custom date by selecting “User 
Defined Date”. Selecting this option displays a textbox allowing that manual entry. 

 

• Progress Method 
o This setting is used to determine how progress will be displayed on the chart. A task’s 

duration will be filled, partially or completely, with a black bar indicating the amount of 
progress made on the task. Available options are the built-in Project fields “% Complete”, 
“Physical % Complete”, and “Status Date”; alternatively, the user may utilize custom 
Number fields to indicate a percentage of progress (e.g. “CAM % Complete”). 

  



 
Operational Decision Software & Services 

Page 11 of 33 
 

700 Boulevard South  Suite 406  Huntsville, AL  35802  Tel: (256) 881-1038  Fax: (256) 881-4791  www.opdec.com 

Advanced Settings 
The Advanced tab of the Settings form provides you with built-in ways to customize the 
appearance of your charts. 
 

 
 

• Contract Date Field 
o This setting displays a Contract Date on the resulting Critical Path chart. The value given 

in the date field specified will be used as the contract date. 
o A symbol (circled blue diamond) will be drawn on the chart on the same row as the 

targeted task’s finish date, and a crisscrossing dotted red line will be drawn from the 
contract date symbol to the target finish date. This is to illustrate and emphasize whether 
the task’s estimated finish date will be before or after the contract date. 
 

• Contract Date Display Text 



 
Operational Decision Software & Services 

Page 12 of 33 
 

700 Boulevard South  Suite 406  Huntsville, AL  35802  Tel: (256) 881-1038  Fax: (256) 881-4791  www.opdec.com 

o If you would like the contract date to be displayed with some identifying text (e.g. “Final 
Completion Date”), you may enter that custom text here. Whatever value you enter will 
be shown to the left of the contract date symbol. This setting is only utilized if the user 
also specifies a Contract Date Field. 
 

• Prepend Value Onto Activity 
o Use this setting to display additional information from one of your schedule fields. 

Common values for this setting are ID or Unique ID, allowing the chart’s viewer to see the 
corresponding ID used in the Project file. This data will be displayed within parentheses, 
and will precede the task name. 
 

• Append Value Onto Activity 
o Use this setting to show information displayed to the right of a task bar. To append 

additional data from a custom text field, you can specify those values here. 
 

• Appended Value Title 
o Only works in conjunction with the “Append Value onto Activity” setting. Whatever text 

you enter here will be displayed before the value specified in the “Append Value” setting. 
 

• Default Number of Paths 
o This option allows the user to specify a default value for the “Paths” option on the main 

form. 
 

• Default Lines per Page 
o This setting allows you to specify the number of rows contained on one page of the 

resulting Milestones Professional chart. By default, the tool will force the entire chart to 
be displayed on one page, which can cause the text to be compressed and illegible. 
Setting a row limit using this option allows your chart to span multiple pages with legible 
text. 
 

• Use Major Event Field as Filename 
o The filenames of charts produced by the tool will be automatically named “[Unique ID] 

Master”. Check this box to instead include the value contained within the Major Event 
field (identified in the Required Settings). 
 

• Always Show Event as Milestone 
o The target event by default will always be shown as a milestone (a diamond symbol with 

no duration). If your targeted task has duration and you want that to be represented in 
the result, you may uncheck this box to show it as a normal task, displayed as a bar 
instead of a diamond representing a single point in time. 
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• Auto Size Chart Height 
o Checking this option will cause the tool to increase the chart’s height based upon 

the number of rows required for the critical path to be shown; specifically, every 
row over 60 will grow the default chart height by an additional 0.16 inches. Note 
that it will most likely render the chart unable to be printed as the default template 
height is already set to standard paper dimensions (8” x 11”). If the charts need to 
be printed, try using the Default Lines per Page setting instead. 
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Additional Pages Settings 
 

 
 

• Display Master Descriptions Page 
o Check this box to create an additional text-based chart result along with your visual 

critical path chart. The additional file will be generated along with every critical path you 
run that provides complementary details to the chart.  

o This is a higher-level detail than the “Path Detail Pages”. It dictates the total duration of 
each path and the number of tasks within it. 

o Note: If you receive errors with this option enabled, please see the Milestones 
Professional Setup section of this document to configure the application for 
automation. 
 

• Display Path Detail Pages 
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o To create a text result file for each path of the critical path, check this box. Up to five 
files will be generated (one for each sub-path). Each of these will dictate the tasks within 
a path, their duration, and other notable details about them. It is similar to the “Master 
Descriptions Page”, but instead of detailing the entire critical path and its sub-paths, it 
will be focused on each sub-path and the tasks within it. 

o When using this option, up to 2 additional columns may be shown on the Path Detail 
pages. You may specify these fields and what their column headers will be in the 
additional options that appear when this box is checked. 
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Managing Multiple Settings Profiles 
The tool allows you to create several different Settings Profiles that can interface to each Project 
file you want to run critical paths on. You can use the Profile dropdown at the top-left of the 
window to Create New Profile, Rename, Save, and Delete profiles. 
 

 
 
You can also convert your old settings profiles from the previous Critical Path 2020 version. To 
do so, click Import Prior Settings Profiles…. Confirm you want to continue, and then validate the 
converted profiles to ensure they are accurate. 
 
Additionally, whether you want to access the Settings Profiles you just converted or simply share 
your profile withy another user, you can click the Open File Location… button. This opens the 
folder where these Settings Profile files are stored. If you want to transfer your settings to 
another user, you can have them use this same button on their device, and then copy/paste your 
files into their profile location. 
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Create a Single Critical Path Chart 
 

 
 

1) Select the Settings Profile applicable to the current schedule. 
 

2) Set the Run Mode to Single Chart 
 

3) Select the task to run a critical path to using the Event Field and Event controls. 
 

a. Event Field – The Microsoft Project field used to find the desired event (task). You 
can set this to Task ID, Task Unique ID, or Major Event Field Value. The Major 
Event Field defined in your Settings Profile determines the Text or Number field 
that will be searched for the Event text you enter. 
 

b. Event – The value to search the corresponding Event Field for. This will be the task’s 
ID, Unique ID, or the text/number value assigned to a task in the Major Event Field. 

 
4) Select the number of Paths to show on the chart. A maximum of 9 sub-paths (10 paths 

total) can be displayed. 
 

5) Select the Template to use. If you did not create your own custom Milestones Professional 
template, use the CriticalPath default template. 
 

6) Click Run.  
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Create Multiple Critical Path Charts 
You can run many critical paths with one button click by using a Critical Path List. To get started, 
select the List Management tab. 
 

 
 

Create a Critical Path List 
The lists you create are assigned to the selected Settings Profile at the top of the window. Each 
Settings Profile can own multiple lists. To create your first list, follow the steps below. 

 
1) Set the List Type 

a. Choose whether your list will be a Unique ID list or a Filter list.  
b. A Unique ID list is just that: a manually input list of task Unique IDs in your schedule 

that you want to run critical paths to. Use the grid at the bottom to compile that list 
by typing Unique ID values into the text box and then clicking Add. You can edit the 
list using the Remove All and Remove Selected buttons at the bottom. 
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c. A Filter list uses a Project schedule filter that you have already created to 
dynamically find the tasks you want to create critical paths for. For example, you 
can create a filter in your Project called “My Major Events” and set the criteria to 
show all unfinished tasks with a value in your Major Event Field as seen in the 
image below. Applying the filter to your schedule will show you what tasks are 
encapsulated by your filter criteria. 
 

 
 
 

Manage Multiple Critical Path Lists 
Use the Options dropdown at the top-left of the window to manage your Critical Path lists. This 
menu gives you the option to Create, Rename, Save, and Delete your lists. These will apply to the 
currently selected list you see in the List dropdown. 
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Using a Critical Path List 
On the Home tab, set the Run Mode to Multiple Charts. 
 

 
 
This removes the Event Field and Event controls in favor of a Critical Path List dropdown. Select 
one of the lists you created in your Settings Profile and click Run. Instead of displaying all the 
charts at the end of processing, the tool will instead notify you that the process is complete. 
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Export Milestone Professional files 
 

 
 
The tool provides a utility to export Milestones Professional images to a Microsoft PowerPoint 
presentation. Each file selected will be placed on slide in the resulting presentation. To get started, 
click Export to PowerPoint tab.   
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• Directory – The text field at the top of the form tells the utility where to find Milestone 
Professional files. The browse button will allow you to select a different directory using a 
Windows dialog. 
 

• Search Subdirectories – This option lets the “Find Now” action know whether to only search 
files within the immediate folder location specified, or whether it should search all subfolders 
within the directory. 

 

• Find Now – Search the directory (and if specified, its subdirectories) for all Milestones 
Professional files. Each file found will be loaded as a checked item in the file display grid below 
it. 

 

• File Display – This list displays all files found by the search. Each file can be checked/unchecked 
to indicate whether it should be exported to PowerPoint. 

 

• Show/Hide Custom Settings – This menu option will expand the export utility interface to 
include the Custom Settings area at the bottom of the interface. These settings will dictate the 
size and position of the image in PowerPoint. 

o The Keyword column contains fields where the user may enter any unique word or 
phrase that will be in the Milestones Professional files' name. Any file name that 
contains the keyword entered will have the corresponding size and position settings 
applied to it when the image is exported to PowerPoint. 

o The Horizontal column should contain how many inches from the left you would like 
your image placed on the PowerPoint slide. This field should correspond to the 
"Horizontal" field in the "Size and Position" window of the image in PowerPoint. 

o The Vertical column should contain how many inches from the top you would like your 
image placed on the PowerPoint slide. This field should correspond to the "Vertical" 
field in the "Size and Position" window of the image in PowerPoint. 

o The Height column should contain the desired height in inches you would like your 
image to be once the image has been placed in PowerPoint. This field should 
correspond to the "Height" field in the "Size and Position" window of the image in 
PowerPoint. 

o The Width column should contain the desired width in inches you would like your 
image to be once the image has been placed in PowerPoint. This field should 
correspond to the "Width" field in the "Size and Position" window of the image in 
PowerPoint. 

 

• Export to PowerPoint – This button will create a PowerPoint presentation with one slide for 
each file in the file listing.  Each page of a Milestone Professional file will become a single slide, 
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so charts with multiple pages will have multiple slides. The generated PowerPoint is not saved, 
so you can save the file with your desired filename and location. 
 

• Force (4:3) Aspect Ratio – This checkbox configures the resulting PowerPoint into a standard 
(4:3) resolution (intended for standard monitors, not widescreen ones). If your images look 
stretched or with extra room on the slide, try setting this option to improve the results. 

 

• Resize Images to Fit Slide – This option forces the chart image to cover the entire slide it is 
placed into. This may be helpful especially in conjunction with charts produced using the “Auto 
Size Chart Height” setting, as these larger images can extend beyond the slide’s width/height. 
This option can either shrink or grow the image and does not consider the original aspect ratio 
of the image. 
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Utilizing Milestone Professional Templates 
The Critial Path Tool display’s data from MS Project by utilizing Milestones Professional templates. 
While a default chart template is provided with the tool, it can be configured to display and report 
various types of information. Some of the more common attributes that are manipulated via the 
template are as follows: 

• Text sizes and placement 

• Graphical indicators 

• Symbol manipulation (for Gantt charts) 

• Introduction of company and/or program logos 

• Legend entries 

• Row shading 

• Much, Much, More 
 
To learn more about utilizing Milestone Professional templates, contact KIDASA software @ 1-800-
765-0167 or OPDEC support @ 256-881-1038  
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Column Properties 
To change the data being populated into a 
templates’ column, double-click the column’s 
header and then the Column Formatting tab. 
The automation tag is used by the Critcial 
Path Tool to determine the type of MS Project 
data that should be populated into it.  This tag 
can be automatically populated by selecting 
the ‘MS Project field’ dropdown and selecting 
the field you would like to display. Doing this 
will automatically populate the automation 
tag with the approriate value. In this example, 
the ‘Baseline Start’ date was selected. Notice 
that the automation tag shows ’baselinestart’. 
 
Symbols and Connectors 
Connectors and symbols can be modified 
within the Milestones Professional personal template. The default template is named 
“CriticalPath.MTP” and located in your installation directory (default is C:\Program Files\OPDEC 
Tools\Critical Path). Use the row and column numbers shown in the image below to reference 
each path bar, symbol, and connector. 
 
1) The horizontal symbols and task connectors for Paths 1-5 can be changed by 

modifying rows 1-5 from the toolbar. Paths 6-10 are in rows 10-14. Column 1 
is the beginning symbol, column 2 is the horizontal connector, and column 3 
is the ending symbol. 

2) The milestone symbols for Paths 1-5 are in rows 6-8. The milestone symbols 
for Paths 6-10 are in rows 15-17. 

a. The status symbol is found on row 8 column 3. 
b. The target finish milestone symbol is found on row 9 column 1. 
c. The forecast finish milestone symbol is found on row 9 column 3. 
d. The contract milestone symbol is found on row 17 column 3. 

3) The horizontal connector between the target finish and the forecast finish is 
found at row 9 column 2. 

4) The vertical connections between the paths can be changed by modifying the 
first vertical connector on row 18 (light-blue background in the image). This is 
the only vertical connector used for all paths. It will change its color to match 
the horizontal connectors for each path. 
 

Note: Symbols can also be manipulated to display values being populated within the columns of 
the chart (visible or hidden). 
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Check Schedule 
The Check Schedule tab looks for potential problems that obstruct the tool’s calculations. Click 
Run to populate the table as seen below. 
 

 
 

The table lists each this check this utility searches for and how many issues were found. 
 

• Summaries with Logic - Indicates the number of summary tasks with a predecessor or 
successor. 

• Multiple Task Calendars - Indicates the number of tasks using an alternate calendar within 
the schedule. 

• Elapsed Durations/Leads/Lags - Indicates the number of activities that are using elapsed 
units of measure in the duration field or in leads/lags. 

• Subprojects - Indicates the number of sub projects contained within your schedule. 

• External Links - Indicates the number of external links utilized in the schedule. 
 
Each issue row in the grid can be clicked to filter your schedule and show the tasks causing the 
problem. The exception is the Subprojects check, which is a count of the total number of 
subprojects inserted into the schedule. 
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Common Errors 
 

1. MSID Not Found in the First Path – The task you are measuring a critical path to (the MSID 
or “Milestone ID”) was not found in the first path. Your target task must be in the first path, 
and this error has no clear resolution. To diagnose the cause, please see the Manual Critical 
Path Steps at the bottom of this section. When you constrain the target task to twenty 
years prior to its target date, it should have the same total slack value as the rest of the 
tasks in its first path. 
 

2. Unable to determine the connection type for [Task ID] – This error is almost always caused 
by either subprojects or external links within the schedule. The tool is unable to connect to 
those external files, and the predecessor/successors relationships cannot be determined 
properly. The tool will assume a Finish-to-Start relationship by default, but there may be 
errors in the resulting chart. You can use the Check Schedule feature to find how many 
subprojects/external links are present to resolve the issue; the only way to do so is to 
merge the schedules into a single file. 
 

3. Unable to determine Path # connection with previous paths – This error is typically caused 
by constraints or deadlines along one path that prevent its total slack from aligning with 
other paths. To investigate, follow the manual critical path steps until Step #3. When 
identifying individual paths based on negative Total Slack, check the Constraint Type, 
Constraint Date, and Deadline columns. If there are any present along the path on tasks 
that are NOT identified as Major Events, it could be skewing calculations and obscuring the 
path connections. Try removing the deadlines or setting the Constraint Type to “As Soon As 
Possible” to produce a more accurate chart. 
 

4. Error number 462 - ‘Remote server machine does not exists’ or ‘RPC does not exist’ – This 
error is usually caused by the tool losing its connection to Milestones Professional. During 
chart creation, the Milestones Professional application is opened and closed several times, 
and sometimes on slower or busier computers, the tool will try to utilize Milestones before 
the application has time to catch up. The resolution to this error is the “Run as Multiple 
Instances for COM/Automation” setting within Milestones Professional. A detailed 
explanation of this setting can be found in the Milestones Professional Setup section of 
this document. 
 

5. Cannot remove constraints/deadlines on major event tasks that are manually scheduled – 
This error means that the tool found tasks in your schedule that were labelled as major 
events (as per the field identified in your settings profile), but were also marked as being 
Manually Scheduled. One of the first steps the tool takes is to release all major events in 
the schedule; this means that all constraint types are set to “As Soon As Possible” and all 
deadlines are set to “NA”. With manually scheduled tasks, Project disables these options, 
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and the tool cannot set any values without encountering errors. The solution to this 
problem is to either set these tasks back to being Auto Scheduled, or to stop identifying 
these manually scheduled tasks as major events (set to blank if Text field, or set to 0 if 
Number field). Please see the image below for an example of this task option. 
 

 
 

6. Error: 429-Cannot Create ActiveX Component – This error usually indicates the tool is 
having difficulty automating Milestones Professional, which is the application our tool 
interfaces with to generate the critical path chart. You may be able to resolve the problem 
by following the steps detailed in the Milestones Professional Setup section of this 
document. 
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Manual Critical Path Steps 
 
Below are the manual steps you can take to calculate the same critical path as the tool. 
Following these can help troubleshoot the cause behind tool errors or confusing critical path 
results. 

 
1. Release all major event tasks. This means to remove any deadlines or constraints from the 

tasks. Major event tasks are the tasks in your schedule with a value in your Major Event 
field (identified in the Settings). To see your major event tasks, filter your Major Event field 
for every non-blank value (or value not equal to zero if using a Number field). 

2. Constrain the event that’s being measured with a “Finish No Later Than” type and set it to 
Finish No Later Than the Target Date minus 20 years. 

3. Sort your schedule on total slack and identify the paths by float value (the first path will be 
the smallest series of unique total slack values). 

a. At this point, your schedule should look something the image below. The 
identification (“This is Path #”) is being made in a custom text field by looking at the 
different sets of Total Slack values. 
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4. Change the constraint date on the event being measured to the target date. Leave the 

Constraint Type as “Finish No Later Than”. 
5. Filter down the visible tasks to only show those identified as part of a path (in Step 3). 
6. Sort the following fields in the following order: path identification field (Empty Text Field in 

your Settings), Finish, Start 
7. Re-evaluate each paths’ logic to check for multiple paths within each unique float value. 
8. Restore the major event tasks’ constraints and/or deadlines. 
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Frequently Asked Questions 
 
In this area, we will address some common questions and problems when running the Critical Path 
tool. 
 

1. Does the Critical Path tool work with schedules with multiple calendars? 
 
No. The tool calculates the critical path based purely on task duration and total slack. 
Utilizing two different calendars (e.g. a five-day work week and a seven-day work 
week) within the same path results in inaccuracies in the Total Slack, and the tool will 
not be able to properly distinguish individual paths. The calendars must be normalized, 
and start/finish dates and durations adjusted accordingly in order to be compatible 
with the tool. 
 

2. Does the Critical Path tool work with lower level schedules that flow up into a master 
schedule via subprojects/external links? 

 
No. The tool is unable to determine connections between tasks across multiple Project 
files. The connection type (e.g. Finish-to-Start, Finish-to-Finish) between successors 
and predecessors is unclear, and the total slack calculations within Project are also 
inaccurate. The tool will typically either give errors or produce inaccurate results. 
 

3. My critical path has a long sequence of tasks, and the resulting chart has overlapping 
task names. Can I extend the chart to make the task names readable? 
 

Yes. There are three ways to do this. By default, the tool will utilize as many rows as 
needed to complete the chart, but the template is sized to be printable. Sometimes 
this results in the text of the task names overlapping rendering it unreadable. There 
are a couple ways to fix this issue. 

 
i. Use the “Default Lines per Page” option in the Critical Path Settings. Setting this 

value in your settings will cause the chart to be created on multiple pages. For 
instance, if your compressed, unreadable chart has 90 rows on one page in 
Milestones Professional, setting this option to 30 will cause the chart to flow onto 
three separate, readable pages. 
 

ii. Use the “Auto Size Chart Height” checkbox in your Settings profile. This option will 
attempt to adjust the chart’s vertical height to give the chart enough room to be 
visible. The “Defaults Line per Page” option will allow the user to spread the chart 
over multiple, printable sheets, while this option will extend the chart vertically 
without regard to its printability. Specifically, for every row over 60 rows in the 
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chart, the vertical height will be extended by 0.16 inches. This allows the text to 
not overlap, but you may get a resulting chart that is very long. 
 

iii. Change the resulting chart’s height and width manually. The default size of the 
template is 8.5 x 11, and increasing those values in Milestones Professional will 
cause the chart to increase in size and therefore making the text readable. The 
chart will be on one page, but may not be printable. 

 
4. Can I export my Settings Profiles to another user or another PC? 

 
Yes. The settings profiles are XML files stored on your device. You can transfer these to 
a predetermined location on another user’s device to share your settings. See the 
Manage Multiple Settings Profiles section of this document for more information. 

 
5. Can I export my Critical Path Lists to another user or another PC? 

 
Yes. Like the Settings Profiles, the Critical Path Lists are stored as text files on your 
device. Navigate to the directory below, and copy/paste the text files found within to 
the same directory on the target device. This directory is one level up from the 
Settings Profiles, so you can use the Open File Location button on the Settings tab to 
navigate there or use the directory given below.  
 
i. C:\Users\Your Username\AppData\Local\OPDEC Tools\Critical Path 2024\Critical 

Path Lists 
 
Note that the “AppData” folder may be hidden; if you cannot see this folder, click on 
the “View” tab of File Explorer and check the “Hidden Items” textbox in the 
“Show/hide” group. The “Your Username” value will be your Windows username. 
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